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SUMMARY

Microtubule dynamics and orientation have crucial roles in many vital cellular
processes. However, functional live imaging of microtubules and/or microtubule
ends in primary microglia can be challenging. Here, we present a protocol for
observing microtubules and microtubule ends in both fixed and live primary mi-
croglia cells. We describe steps for microglia culture and in vitro stimulation, SiR-
tubulin labeling, lentivirus preparation, live imaging, immunostaining, and image
acquisition. We also provide procedures for SiR-tubulin, EB3-EGFP, and EB1 an-
alyses.
For complete details on the use and execution of this protocol, please refer to
Rosito et al. (2023).1

BEFORE YOU BEGIN

The protocol below describes the step-by-step procedure to obtain primary murine microglia as

described in Rosito et al.1,2 Microglia are the brain’s innate immune cells, which play a crucial role

in maintaining a healthy brain environment. In their homeostatic state, microglia have a ramified

morphology and continuously patrol the local environment by extension and retraction of highly

motile processes.3 However, in situations involving neuronal inflammation, injury, and neurode-

generative disorders, microglia undergo significant changes in both gene expression and

morphology.4–6 Despite the advantage of a controlled setting that primary cultures offer for inves-

tigating these cells, microglia in vitro experience widespread molecular alterations7 as a result of the

loss of signaling with other cells in the brain microenvironment, which is crucial for maintaining them

in a state of homeostasis.

Hence, it is essential to fine-tune the culture conditions of these cells to minimize the modifications

caused by the culturing environment. Here, we suggest a strategy that involves firstly a co-culture of

astrocytes andmicroglia, than microglia isolation and plating with a medium with low serum concen-

tration supplemented with astrocyte conditioned medium.9 Since in the tissue microglia typically

occupy distinct domains,11,13 we also suggest plating cells at low cell density to avoid domain over-

lapping. Increased numbers of amoeboid-shaped microglia cells and/or decrease in the percentage

of ramified forms are indications of microglia activation induced by culture conditions that is useful

to consider throughout this entire protocol. For a detailed description of morphological parameters

useful to discriminate activated morphologies, refer to Figure 1B-D of Rosito et al., 2023.1
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It is possible to steer microglia toward different reactivity states,15 such as an activated or an alter-

natively activated state, challenging the cells with either lipopolysaccharide-interferon g (LPS-IFNg)

or interleukin-4 (IL-4), respectively. The details for this induced in vitro polarization are provided in

Preparation one.

Prior to beginning these experiments, key resources (listed in the key resources table) should be

available.

Before starting the dissection as described in Preparation one, coat T75 flasks with poly-L-lysine so-

lution (5–10 mL in each flask) and expose them to UV light for 20 min. Prior to plating cells, rinse the

flasks once with DMEM. This procedure can also be applied to multiwell plates, glass coverslips, or

chambered slides (e.g., m-Slide 8 Well, ibidi).

Prior to initiating the lentiviral preparation as outlined in Preparation three, plate HEK 293T cells on

150 mm dishes to achieve 60%–80% confluency on the day of transfection.

Institutional permissions

All procedures performed in this study using laboratory animals were in accordance with the Italian

and European guidelines and were approved by the Italian Ministry of Health in accordance with the

guidelines on the ethical use of animals from the European Communities Council Directive of

September 20, 2010 (2010/63/UE). It is crucial to obtain the required permissions from the relevant

institutions before carrying out the dissection steps outlined in this protocol. All experiments

performed at Columbia University were approved by the Committee on the Ethics of Animal Exper-

iments of Columbia University and performed according to Guide for the Care and Use of Laboratory

Animals distributed by the National Institutes of Health.

Preparation one: Establishing the primary microglia cell culture

Timing: 14 days

Timing: 1 h (for step 1)

Timing: 1 h (for step 2)

Timing: 10–14 days, hands-on: 2 h (for step 3)

Timing: 48 h (for step 4)

1. Brain dissection: cortex isolation.

a. Decapitate the mouse pup quickly with scissors. Pups should be anesthetized on ice accord-

ingly to approved animal protocols and institutional permissions.

b. Open the skull by gently cutting the skin and the skull in the median scissure, from caudal to

rostral.

c. Firmly grab the skin and the skull from the rostral part of the cut and tear it.

i. Repeat for the second hemisphere.

ii. Delicately but firmlypulling the tissues shouldbesufficient to removeboth the skull and the skin.

Note: the skull at this mouse age is really soft. Perform this procedure delicately to avoid

damaging the brain tissue.

d. Once exposed, transfer the brain into a petri dish on ice.

e. Separate the cerebellum and the olfactory bulb from the rest of the brain.

f. Separate the hemispheres.
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g. Remove the meninges.

h. Separate the cortex from the subcortical structures.

Note: use a stereoscope to better visualize the subcortical structures.

i. Put the cortex in ice cold dissection medium in a 50 mL Falcon conical tube (maximum 5

cortices per tube) until the next step.

CRITICAL: the age of the pup will determine the yield of the cell culture. Use pups in the

range P0–P1 for optimal yield, do not use pups older than P2. The yield is variable but opti-

mally in the range of 1–2.5 x 106 cells per T75 flask.

2. Tissue digestion and cell plating.

a. Aspirate dissection medium from the tube and wash twice with fresh dissection medium (see

composition in the materials and equipment section).

b. Aspirate the dissection medium and add 1.5 mL of papain solution per brain (see composition

in the materials and equipment section).

c. Transfer the tube to 37�C for 20 min (after 10 min, gently shake the tube).

d. Aspirate the papain solution from the tube and wash gently once with dissection medium and

once more with 10 mL of medium for glial culture.

e. Add 1.5 mL of medium for glial culture to each cortex, mechanically dissociate twice with a

glass Pasteur pipette and then tap vigorously the tube 10–20 times.

f. Wait 1–2 min for the debris to deposit at the bottom of the tube, then filter the supernatant

with a 100 mm cell strainer: filter max 5 brains per cell strainer.

g. Repeat the passages e-f if the pellet is still abundant.

h. Add medium for glial culture up to 25 mL per 50 mL Falcon conical tube.

i. Plate the cells on T75 flasks using 12.5 mL of medium per flask (considering 2–2.5 corteces per

flask).

3. Microglia isolation and plating.

a. Leave the flasks in the CO2 incubator at 37�C for at least 10 days and up to 14 days.

i. By phase microscopy, microglia should appear as small, bright cells growing on top of a

layer of astrocytes.

ii. If needed, a change of medium can be performed at day 4 or 7. The medium can be

changed entirely or by adding fresh medium to half volume of the conditioned medium.

iii. The number of microglia cells should increase exponentially in the last few days in culture.

b. At confluence (max 14 DIV), isolate microglia cells from the underlying astrocyte layer:

i. Shake the flasks at 37�C (115–120 rpm) for 1 h and 30 min.

CRITICAL: excessive shaking can activate microglia cells. Upon shaking, most microglia

cells will be in suspension, although some will remain attached to the astrocyte layer.

c. Keep the flask horizontal and vigorously tap it twice to help cells detach.

i. Collect the supernatant and filter it through a 70 mm cell strainer.

ii. Spin the cells down at 1000–1200 rpm for 7 min.

iii. Remove and save part of the medium as astrocyte conditioned medium (ACM).

d. Disperse the pellet and estimate viable cell number using a Thoma cell counting chamber.

e. Resuspend the desired number of cells in medium composed of half ACM and half fresh

DMEM supplemented with 2.5% FBS.

CRITICAL: a higher percentage of serum may activate microglia.

f. Plate the cells in the desired dish or plate, e.g., Ibidi m-Slide 8Well, pre-coated as described in

the before you begin section.
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i. To minimize activation due to in vitro culturing conditions, plate microglia at low cell density

(e.g., 73 103/cm2). When plating microglia cells for infection, plate 13 104/cm2 in 250 mL in

ibidi m-Slide 8 Well.

4. Microglia polarization.

a. The day after plating, cells are induced to polarize in the presence of LPS and IFNg or IL-4

for 48 h:

b. Add LPS at 100 ng/mL and IFNg at 20 ng/mL to obtain activated microglia.

c. Add IL-4 at 20 ng/mL to obtain alternatively activated microglia.

CRITICAL: Microglia polarization can be achieved by adding the cytokines directly into the

medium or by removing only half of the medium and adding an equal volume of fresh me-

dium already containing the cytokines at 23 of the final concentration.

5. Identification of reactive microglia.

a. Morphology and gene expression should be characterized to determine the reactive state of

microglia cells in culture. Refer to Rosito et al., 20231 for morphological characterization of

activated and alternatively activated microglia.

Preparation two: Microtubule labeling and live-imaging

Timing: 3 h

6. Reconstitute SiR-tubulin and Verapamil by following the manufacturer instructions (https://

www.cytoskeleton.com/pdf-storage/datasheets/cy-sc002.pdf).

7. Replace half of the medium with astrocyte conditioned medium and add SiR-tubulin to a final

concentration of 100 nM and Verapamil to a final concentration of 10 mM.

8. Incubate at 37�C for 30 min.

9. If the signal is too dim, wash the cells once with conditioned medium prior to visualization to

improve signal to noise ratio.

10. Acquire time lapse movies of microglia SiR-tubulin labeled microtubules, using standard Cy5

settings, maintaining the temperature at 37�C during recordings. We found the acquisition to

be optimal using an Olympus IX73 microscope, LDI laser source and CoolSNAP Myo camera,

4.54 mm pixels (Photometrics) with a built-in incubator with acquisition rate of 1 frame/4 s for

4 min with a UPLSXAPO 1003/1.45 oil objective. Only one or two cells should be imaged per

field.

Note: we determined that wide-field microscopy was suitable for detecting optimal signal to

noise ratio by focusing on the thin edge of the cell: it is easier to identify microtubules in a

distal region where the cell displays a thin edge, compared to the region proximal to the nu-

cleus where microtubules are more densely packed (see Figure 1 as an example). Additionally,

an acquisition rate of 1 frame per 4 s for a duration of 4 min was found to be optimal for mini-

mizing photobleaching. Avoid washing steps before imaging.

Preparation three: Lentivirus preparation and microglia lentiviral infection

Timing: 3 days

11. Transfect HEK 293T cells at 60%–80% confluency with the lentiviral expression plasmid and len-

tiviral packaging plasmids (pLP1, pLP2, and pLP-VSV-G):

a. For each 150 mm dish, mix 20 mg of lentiviral expression plasmid encoding EB3-EGFP pLVX-

EB3-EGFP, 12 mg of pLP1, 4 mg of pLP2 and 6 mg of pLP-VSVG with sterile ddH20 in a 5 mL

polystyrene round bottom tube up to 750 mL of total volume.

b. Add 250 mL of sterile 2 M solution of CaCl2.
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c. While gently vortexing, add dropwise 1 mL of transfection buffer 23 pre-warmed at 37�C
(see composition in materials and equipment section).

Note: the reaction between Na2PO4 contained in the transfection buffer, CaCl2 and DNA will

form calcium phosphate/DNA precipitate visible at the naked eye as a faint blue tinge.

d. Quickly add the mixture to the dish of HEK 293T cells dropwise and gently agitate the dish.

e. Replace the medium with 14 mL of fresh medium at 6 h after transfection.

12. Harvest and freeze the virus:

a. Collect the medium 12, 24 and 36 h after transfection using the same Falcon 50 mL tube,

filling it up to 40 mL of medium. Harvested virus can be stored at 4�C. Filter the virus with

a 0.45 mm filter system to remove debris.

b. Add 10 mL of lentiviral precipitation solution, mixing well by inverting the tube.

c. Leave at 4�C for at least 6 h.

d. Centrifuge the 50 mL tube twice at 1500 3 g for 30 min at 4�C to collect the viral pellet.

e. Resuspend the pellet in 400 mL of medium and store at �80�C.

Note: virus titer is stable at �80�C for at least one year. Avoid multiple freeze-thaw cycles.

13. Infect microglia cells.

a. After plating microglia cells at 13 104/cm2 in 250 mL as described in preparation one, wait at

least 24 h before proceeding with the infection to let cells attach.

b. Add 20 mL of virus for each well and wait 24–36 h before imaging.

Note: This protocol produced a viral titer of 2 * 10^8 IU/mL. In our hands, the added volume of

virus (20 mL) produced the highest infection efficiency and the best signal to noise ratio for

EB3-EGFP comets during live imaging. The expected outcome is described in Figure 5.

14. Acquire videos using an epifluorescencemicroscope. We used a Nikon Eclipse Ti equipped with

an Orca II ER charge-coupled device (CCD) camera (Hamamatsu, Hamamatsu, Japan) and a

temperature-controlled (37�C) CO2 incubator using a 603/1.40NA objective at 1 frame every

2 s for at least 3 min.

Preparation four: Immunostaining of fixed microglia cells

Timing: 2 days

15. For optimal microtubule staining, fix the cells on Ibidi m-Slide 8 Well plates with ice-cold (stored

at �20�C) methanol for 4 min at �20�C and rehydrate them with PBS at R.T. for at least 30 min.

16. Block the cells with 3% BSA in PBS for 45–60 min.

Figure 1. Microtubule tracing

Example of microtubule tracing between successive frames using the «Freehand line » tool in ImageJ from a microglia

cell activated with LPS-IFNg. Scale bar is 10 mm. The reference point is highlighted with a green dot. Note that the

distal, thin edge of the cell presents more distinguishable microtubules compared to the center of the cell.

ll
OPEN ACCESS

STAR Protocols 4, 102499, September 15, 2023 5

Protocol



17. Incubate with primary antibodies plus 1.5% BSA in PBS overnight at the following concentrations:

rat tyrosinated tubulin YL 1/2, Merck-Millipore, 1:1000; mouse EB1, BD Biosciences, 1:100.

18. Wash with PBS three to four times.

19. Incubate with minimally cross-reactive fluorophore-conjugated secondary antibodies in PBS

(Alexa Fluor 488 goat anti-rat, 594 goat anti-mouse) and Hoechst (Sigma-Aldrich) for nuclei visu-

alization for 1 h at R.T.

20. Wash three to four times with PBS.

21. Mount using a few drops of Ibidi Mounting Medium.

22. Let the mounting medium sit for at least 6 h to overnight at 4�C.
23. Acquire images at a confocal microscope: we found the acquisition to be optimal using a Nikon

Eclipse Ti confocal microscope equipped with X-Light V2 spinning disk (CrestOptics, Rome,

Italy) and an LDI laser source (89 North, Williston, VT, USA) and Prime BSI Scientific CMOS

(sCMOS) camera, 6.5 mm pixels (Photometrics) with a 1003/1.45 Plan E oil objective, with a

z-step size of 0.2 mm.

KEY RESOURCES TABLE

MATERIALS AND EQUIPMENT

For primary microglia cell culture preparation.

REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

EB1 (mouse monoclonal) 1:100 BD Biosciences Cat#610535; RRID AB_397892

Tyr tubulin (rat monoclonal) 1:1000 Millipore Cat#MAB1864; RRID AB_2128189

Alexa Fluor 488 goat anti-rat 1:500 Invitrogen Cat#A11006; RRID AB_141373

Alexa Fluor 594 goat anti-mouse 1:500 Invitrogen Cat#A11032; RRID AB_2534091

Chemicals, peptides, and recombinant proteins

Murine recombinant IL-4 PeproTech Cat# 214-14

Murine recombinant IFNg PeproTech Cat# 315-05

LPS from E. coli Sigma-Aldrich Cat# L4391

Hoechst Sigma-Aldrich Cat# 23491-45-4

Poly-L-lysine hydrobromide Sigma-Aldrich Cat# P6282

Dulbecco0s modified Eagle0s
medium (DMEM)

Sigma-Aldrich Cat# D6546

Fetal bovine serum (FBS) Gibco Cat# 11573397

Lentiviral precipitation solution ALSTEM Cat# VC100

Critical commercial assays

SiR-Tubulin Kit Spirochrome Cat# CY-SC002

Experimental models: Cell lines

HEK 293T ATCC CRL-3216

Experimental models: Organisms/strains

Mouse: C57BL/6 pups post-natal day 0–2 Charles River Laboratories 027C57BL/6

Recombinant DNA

EB3-EGFP Pero et al.8 N/A

pLP1, pLP2, and pLP-VSVG Thermo Fisher N/A

Software and algorithms

GraphPad Prism v9.0 GraphPad https://www.graphpad.com

FIJI/ImageJ 1.53c Schindelin et al.10 http://www.imagej.nih.gov/ij

Other

m-Slide 8 Well ibidi Cat# 80826

ibidi Mounting Medium ibidi Cat# 50001
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� Poly-L-lysine solution: 5 mg to dissolve in 50 mL of ddH2O.

Prepare fresh or store at �20�C up to 1 month.

� Dissection medium: HBSS with 10 mM HEPES.

Store at 4�C for a maximum of 3–4 weeks.

� Medium for glial culture: DMEM supplemented with 10% FBS.

Store at 4�C for a maximum of 3–4 weeks.

For lentivirus preparation.

� HEK 293T media: DMEM with 10 mM HEPES and 10% BCS

CRITICAL: Follow institutional approved guidelines and use certified personal and collec-

tive protective equipment for virus handling.

STEP-BY-STEP METHOD DETAILS

Live cell analysis: Sir-tubulin labeled microtubule length tracing

Timing: 2 h (per time-lapse movie)

This step enables the analysis of microtubule dynamics by tracking changes in microtubule length

between successive frames of a time-lapse movie. The analysis accounts for potential bending or

movement of the microtubule and can be performed using tools available in ImageJ software.

Note: This analysis has been adapted from Dhamodharan and Wadsworth 1995,12 Dhamod-

haran et al., 1995,14 Rusan et al. 2001.16

Papain solution

Reagent Final concentration Amount

Papain 16 units/mg N/A 30 mL

EDTA (50 mM) 0.5 mM 15 mL

CaCl2 (150 mM) 1.5 mM 15 mL

Cysteine 20 mg/mL 0.2 mg/mL 15 mL

DNase 0.1 mg/mL 0.1 mg/mL 1.5 mL

Dissection medium N/A 1.42 mL

Total N/A 1.5 mL each cortex

Prepare freshly before dissection in sterile conditions, keep at R.T. until use.

Transfection buffer 23

Reagent Final concentration Amount

HEPES 55 mM 6.553 g

NaCl 270 mM 7.889 g

Na2PO4$2H2O 1.5 mM 0.133 g

Total N/A 500 mL

Sterilize and adjust pH = 7.05. Store in aliquots at �20�C. Multiple freeze-thaw cycles do not affect transfection efficiency.
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For image preparation, use ImageJ for level adjustments of frame brightness and contrast, and back-

ground subtraction.

1. Microtubule tracing:

a. Use ImageJ to open the movie obtained by recording SiR-tubulin labeled microglia.

b. Invert LUT using ImageJ dedicated command.

c. Select a ‘‘substack’’ to extract from a stack a selected image in which microtubules are clearly

visible.

i. From ‘‘Image’’ menu, select ‘‘Stacks’’, then ‘‘Tools’’ and ‘‘Make substack’’.

d. Select one microtubule that is visible for the duration of the entire substack.

e. Choose a reference point that is stable for the duration of the entire substack and make a note

of its XY coordinates.

f. Starting from the reference point, trace a line using the ‘‘Freehand line’’ tool, outlining the

microtubule entire length.

g. If needed, draw the microtubule for future reference selecting ‘‘Draw’’ from the ‘‘Edit’’ menu.

h. Measure the length of the selection with the ‘‘Measure’’ command in the ‘‘Analyze’’ menu.

i. Change frame and repeat, making sure to trace the line from the same reference point, until

the end of the ‘‘substack’’.

2. Report the measurements and measure microtubule dynamics parameters:

a. Copy the values into an Excel file.

b. Starting from the second frame, measure the difference in length with the previous frame.

c. For each difference value, note if it represents a ‘‘growth’’ (positive value), ‘‘shrinkage’’ (nega-

tive value) or ‘‘pausing’’ (value % 0.5 mm) event.

d. For each ‘‘growth’’ or ‘‘shrinkage’’ event, divide the absolute value by the time interval

between frames to obtain a ‘‘growth’’ or ‘‘shrinkage’’ rate in mm/s, and average all values to

obtain an ‘‘average growth’’ or ‘‘shrinkage rate’’ in mm/s.

e. Count the number of ‘‘growth’’, ‘‘shrinkage’’ or ‘‘pausing’’ events and divide each one by the

number of total events (‘‘growth’’ + ‘‘shrinkage’’ + ‘‘pausing’’) to obtain a percentage of

‘‘growth’’, ‘‘shrinkage’’ and ‘‘pausing’’.

f. Calculate the total time of analysis (in seconds) by multiplying the number of frames by the

time interval between frames.

g. Count the number of transitions between ‘‘growth’’ and ‘‘shrinkage’’ (catastrophe) and vice

versa (rescue).

h. Calculate ‘‘catastrophe’’ or ‘‘rescue frequency’’ by dividing the number of ‘‘catastrophe’’ or

‘‘rescue’’ events by the product between the percentage of ‘‘growth’’ or ‘‘shrinkage’’ and

the total time of analysis.

i. Calculate microtubule ‘‘dynamicity’’ by dividing the sum of all the ‘‘growth’’ or ‘‘shrinkage’’

event absolute numbers by the total time of analysis.

CRITICAL: Draw the line as carefully as possible, comparing successive frames through the

entire video to follow the behavior of the entire microtubule. This will help discriminate the

microtubule when the frame is blurred or unclear. See Figure 1 as an example.

Note: As an indication, at least 30 substacks per condition from three independent culture ex-

periments should be analyzed for a treatment comparison.

Live cell analysis: EB3-EGFP comet kymograph analysis

Timing: 2 h (per cell)

This widely used procedure allows for the analysis of microtubule plus end dynamics and orientation

in ramified segments of homeostatic microglia.
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Note: the signal of microtubule plus end binding (EB) proteins (later defined as ‘‘comet’’)

typically decays exponentially after the maximum at the microtubule end that is toward the

microtubule lattice.17,18

3. Obtain a kymograph from an EB3-EGFP microglia movie:

a. Use ImageJ to open the movie obtained by recording EB3-EGFP comets in expressing

microglia.

b. Invert LUT using ImageJ dedicated command.

c. Select a ‘‘substack’’ based on the planes where the signal is bright and the EB3 comets are

clearly trackable.

d. With the ‘‘Segmented line’’ tool, select the section thatwill be analyzedby the Kymograph plugin.

Note: Adjust the line width to cover the region that will be analyzed and make a note of the

value.

e. From the ImageJ Plugin menu, select ‘‘Kymograph’’ and ‘‘Kymograph builder’’.

Note: The resulting kymograph displays the line length as X, and the time as Y (as displayed in

Figure 2). Make sure the values are based on the correct pixel-micron conversion by checking

the original file properties from ‘‘Image’’ menu.

4. Calculate the percentage of anterograde and retrograde comets.

Note: The direction of the drawn line will determine the direction of the comets (as explained

in Figure 2): by drawing the line from the proximal part of the process towards the distal part

with respect to the nucleus, the resulting kymograph will display anterograde comets as

directed from left to right, while retrograde comets will be directed from right to left

(Figure 2B).

5. Comet analysis (optional):

a. Report on an Excel file the Frame interval, theNumber of analyzed frames and the Duration of

the analyzed substack, obtained by multiplying the number of analyzed frames for the frame

interval.

Figure 2. Example of Projected kymograph and outline of Complete comets

(A) Frame from a movie obtained from EB3-EGFP expressing homeostatic microglia (Scale bar: 20 mm). The yellow line is obtained with the «Segmented

line » tool, with known width and indicates the region from which the kymograph is obtained in B. The direction of the drawn line is highlighted by the

arrow and will determine the direction of the comets in the kymograph in B.

(B) Projected kymograph with Complete comets highlighted in yellow and numbered with the ImageJ ROI manager. Comets number 1, 2, 6 and 13 are

defined as Retrograde.
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b. Report the analyzed cell Process length and Process width in mm, defined by the length and

the width of the drawn line, respectively.

c. On the Projected kymograph, outline with the ‘‘Freehand line’’ tool the complete comets to be

analyzed and add them to the ROI Manager, from the ‘‘Tools’’ section in the ‘‘Analyze’’ menu.

See Figure 2 for an example of Projected kymograph and Complete comets.

Note: Comets are defined as ‘‘complete’’ if not intersecting with the borders of the Projected

kymograph and the start and the end of it are clearly identifiable.

6. Microtubule dynamics analysis (optional):

a. For each comet outlined in the Projected kymograph, measure Length of growth (covered dis-

tance on the X axis) and Comet lifetime (projection on the Y axis of the comet trajectory) as in

Figure 3.

b. Convert the value of the Comet lifetime from microns to seconds.

Note: The width of the drawn line in pixels (Process width in pixels) will define the number of

pixels corresponding to the Y axis of the kymograph; by multiplying this number for the pixel di-

mensions in microns (determined by the camera and the objective used during acquisition) the

Value of the Y axis of the kymograph (microns) will be obtained. The conversion of the Comet

lifetime value from micron to seconds will be therefore obtained as [(Comet lifetime in microns

* Duration of analyzed substack in seconds) / Value of the Y axis of the kymograph in microns].

c. Calculate comet Growth rate as Length of growth / Comet lifetime and the other desired pa-

rameters accordingly.

Note: the number of kymographs that provide a statistically valid sample size will be depen-

dent on the length of the lines that can be drawn to cover the extension of a process (or most of

the cell area in the case of an amoeboid cell). Approximately, one should collect a number of

kymographs to cover at least 10 processes per experiment (e.g., at least 2 kymographs per

microglia, 5 microglia per experiment) and three independent experiments.

Fixed cell analysis: EB1 fluorescence gradient analysis

Timing: 2 h

The comet-shaped accumulation of EBs at microtubule ends, with the intensity of comet tail decay-

ing exponentially from the maximum at the microtubule end, enables the measurement of fluores-

cence intensity gradients of EB-positive comets relative to the location of the nucleus. Although live

imaging of EBs remains the gold standard technique, this approach is straightforward and reproduc-

ible in our hands. This method enables the definition of anterograde or retrograde comets by using

the fluorescence intensity gradient of endogenous EB protein signal from immunolabeled fixed

cells. This method can also be applied to single frames of EB3 movies.

Figure 3. Example of Comet lifetime and Length of growth measurement X and Y projections of the comet

(highlighted in yellow) represent Length of growth and Comet lifetime, respectively (dashed lines, black)
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7. Open images of EB1 and Tyr-tubulin from immunostained microglia cells in ImageJ.

8. Using the signal of Tyr-tubulin as a reference, identify EB1 comets at the plus end of tyrosinated

microtubules.

9. Measure fluorescence intensity signal of EB1 at the tip of the microtubule defined by Tyr-tubulin:

a. Open the EB1 channel.

b. Invert LUT.

c. With the ‘‘Freehand line’’ tool, draw a line starting from the end of the comet proximal to the

nucleus.

Note: depending on the microtubule distribution and on the cell shape, the fluorescence

gradient of different comets may occur at varying degrees relative to the direction or trajec-

tory: draw the lines accordingly. Select as many clearly detectable (e.g., bright signal at the

maximum of the tip of the comet, with comet tail intensity decaying exponentially) comets

as possible. At least 100 comets will be needed from at least three independent experiments.

d. Increase the line width to cover the width of the comet.

e. With the ‘‘Plot profile’’ command from the ‘‘Analyze’’ menu, obtain a line scan of the selection

for each comet.

f. If the peak of the line scan is in the second half of the plot, define the comet as Anterograde.

Otherwise, define as Retrograde, as in Figure 4.

EXPECTED OUTCOMES

By following the Sir-Tubulin analysis protocol, it is possible to measure changes in microtubule

length in microglia cells, which are known to be resistant to transfection and lentiviral infection.

This allows for the analysis of microtubule dynamics while accounting for potential bending and/

or movement of the microtubule.

Lentiviral infection of microglia with EB3-EGFP may result in low efficiency due to the tendency of

microglia cells to activate and react to infections. Nevertheless, this protocol enables the identi-

fication of growing microtubule plus ends in infected microglia, which appear as a bright, elon-

gated comets, compared to the lower intensity of intracellular fluorescent puncta (see Figure 5).

It should be noted that LPS-IFNg activated microglia are particularly difficult to infect. Using

this protocol, it is possible to identify retrograde EB3 comets in microglia ramifications and

analyze their dynamic behavior in living cells. In fixed cells, the protocol is applicable to minimally

manipulated cells and allows for the identification and quantification of both anterograde and

retrograde EB1 comets.

LIMITATIONS

By following this protocol, it is possible to analyze different parameters that describe the dynamics

and orientation of microtubules and growing microtubule plus ends in microglia cells.

SiR-Tubulin labeling of microglia microtubulesmay result in dim signals, that we could image only for

a short period of time (4 min) before photobleaching occurs. Also, during imaging, microtubules can

drift out of focus, making the analysis challenging. Prolonged exposure to Taxol derivatives, such as

SiR-tubulin, may alter the dynamicity of the microtubules: we found 4–5 min of imaging with 100 nM

of SiR tubulin as a reasonable time frame to avoid this problem. It should also be noted that SiR-

tubulin labels all microtubules, including depolymerizing and pausing, whereas comet analysis

only labels growing microtubule plus ends due to the kinetics of EB protein binding. This can result

in different dynamicity values arising from the two analyses that are not directly comparable.

In our hands, EB3-EGFP lentiviral infection of microglia cells resulted in a low percentage of EB3-ex-

pressing cells (around 1%) even when varying the amount of virus and incubation time after the
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infection: therefore, the cells that are not expressing EB3-EGFP might represent a specific subtype

of microglial state (e.g., activated). Indeed, we did not succeed in infecting LPS-IFNg activated cells

and could only analyze comets from homeostatic and alternatively activated cells. As mentioned

before, photobleaching may occur after 3 min of live cell imaging also for these cells.

TROUBLESHOOTING

Problem 1

Low yield of microglia culture (Related to preparation one: primary microglia cell culture).

Potential solutions

� The optimal age of the pups is postnatal day 0 to postnatal day 1. The use of younger animals may

result in a better yield.

Figure 4. Analysis of EB1 fluorescence intensity gradients

Example of analysis of EB1 fluorescence intensity gradients from homeostatic microglia. Top: representative image of microglia immunolabeled for

tyrosinated a-tubulin (Tyr tub, green) and microtubule end binding protein EB1 (magenta), Hoechst for nuclei visualization (blue), and EB1 inverted LUT

signal (left); Scale bar: 20 mm.

Bottom: zoom of regions A (magenta) and B (green) highlighted in EB1 inverted contrast image (scale bar: 2 mm) and relative analysis: a line is drawn

following the direction of the arrow, from the proximal to the distal part of the cell with respect to the nucleus. If the peak of the line scan is in the second

half of the graph, the comet is defined as Anterograde (A1, B1), otherwise as Retrograde (A2, B2).
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� Use fresh solutions and keep the tissues on ice for the duration of the dissection. Dissect the brain as

quickly as possible, and rapidly plate the cells in the final medium at 37�C, without leaving them on

ice, in the dissection medium, or at R.T. for too long. Adjust the number of cortices per flask accord-

ing to the yield obtained by the operator. A mixed glia culture (up to DIV 14) is illustrated in Figure 6.

Problem 2

High levels of cellular debris (Related to preparation one: primary microglia cell culture).

Potential solution

Reduce the trituration obtained by mechanical dissociation. Reduce the volume of enzyme added to

the papain solution. Freshly prepare papain solution and medium for each dissociation. Do not filter

more than 5 cortices with one cell strainer.

Problem 3

Low attachment of cells (Related to preparation one: primary microglia cell culture).

Potential solution

Carefully coat all the flasks and wells. Use freshly prepared poly-L-lysine solution and freshly coated

supports.

Problem 4

Poor microtubule labeling (Related to preparation two: microtubule labeling and live imaging).

Potential solutions

� Increase the time of incubation with the probe or its wash off to increase the signal-to-noise ratio.

� Keep the labeling solution and the labeled cells in the dark. Label the cells right before imaging.

Minimize the time during which cells are exposed to the light of the microscope and adjust light

source power to avoid photobleaching.

� Refer to the manufacturer instructions for probe reconstitution, storage, handling and labeling for

optimal results. Add Verapamil accordingly to manufacturer instructions to inhibit efflux pumps

and improve labeling.

Figure 5. Example of EB3 comets recognition in EB3-EGFP expressing microglia

Example of EB3-EGFP expressing microglia cell from an untreated (homeostatic) culture. Scale bar: 20 mm. It should

be easy to identify EB3 comets (highlighted in the blue zoom) from fluorescent puncta (orange zoom image); scale bar:

2 mm. Note that the puncta highlighted in the orange zoom come from an amoeboid (likely activated) cell. Activated

cells display an increased number of fluorescent puncta that may hinder the identification of EB3 comets. One should

consider analyzing these cells too as a distinct pool of ‘‘activated’’ cells.
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Problem 5

Poor efficiency of lentiviral infection (Related to preparation three: lentivirus preparation and micro-

glia lentiviral infection).

Potential solution

Since the microglia culture, especially when activated, is refractory to lentiviral infection and the viral

preparations may differ in titer, we suggest increasing the volume of virus used and/or by removing

some medium before the infection. Increasing the density of the microglial culture would also

improve infection. Note however that higher microglia density may also lead to a higher degree

of in vitro microglia activation.

Problem 6

Poor comet and/or microtubule labeling (Related to preparation four: immunostaining of fixed mi-

croglia cells).

Potential solutions

� Fix with a high volume of ice-cold methanol to preserve microtubule integrity during fixation and

wash well for proper re-dehydration before immunolabeling.

� Freshly prepare BSA and antibody solutions and wash well when needed, being careful not to let

cells detach.

� Let the mounting medium sit at least overnight, then image the sample as soon as possible to

avoid photobleaching.

� Store the sample in the dark at 4�C, wrapped in parafilm to avoid evaporation.

Problem 7

Problems in visualizing microtubule movement (Related to live cell analysis: Sir-tubulin labeled

microtubule length tracing).

Figure 6. Example of mixed glia culture

Example of DIV 12 mixed glia culture. Note the astrocyte layer and the bright microglia cells laying on top of it. Scale

bar: 100 mm.
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Potential solution

Because it can be hard to visualize microtubule movement between frames, always keep the entire

stack to be able to go back and forth and identify themovement. Add the tracedmicrotubule section

to the ROI manager to keep track of the movement between frames.

Problem 8

Problems in identifying the fluorescence intensity gradient of EB comet (Related to fixed cell anal-

ysis: EB1 fluorescence gradient analysis).

Potential solution

Measure the same comet multiple times, slightly changing the selection of the line scan to make sure

to identify the peak of fluorescence intensity. Make sure to cover the entire length and width of the

comet when measuring fluorescence intensity to average the signal correctly.

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Silvia Di Angelantonio (silvia.diangelantonio@uniroma1.it).

Materials availability

This study did not generate new unique reagents.

Data and code availability

This study did not generate datasets.
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